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Introduction

The User Console is a fun, easy to use, web-based design environment where you can analyze data, create
interactive reports, dashboard reports, and build integrated dashboards to share business intelligence
solutions with others in your organization and on the internet. In addition to its design features, the User
Console offers a wide variety of system administration features for configuring the Business Analytics (BA)
Server, maintaining Pentaho licenses, setting up security, managing report scheduling, and tailoring system

performance to meet your requirements.

Prerequisites

Before you can work with the User Console, install the Pentaho software and configure the BA Server.

Expertise

The User Console does not require any special skills or knowledge to use its design environment. However, to
use its system administration features you should know where your data is stored and how to access it, as well

as details about your system configuration and security providers.

Tools

Through the User Console you can access these Pentaho tools and features, as well as the BA Repository on

the BA Server.

= Analyzer

= Interactive Reports

= Dashboard Reports

= Dashboard Designer

= Data Source Wizard

= Data Source Model Editor
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Tour the Pentaho User Console

If you use file management tools or any web browser, you should feel right at home with the User Console. To
familiarize yourself with the different pages and controls of User Console, let us take you through a quick tour.

Login to the User Console

Follow these steps to login to the User Console:

1. Launch a Web browser and enter the URL of the Pentaho server. The page loads an introductory screen
with a Login section.

2. Enter your user name and password and click Login.

‘@ pentaho

User Console

You are now logged into the User Console and ready to start creating and running reports and
dashboards.

Home

The first thing you see after you log into the User Console is the Home page, which serves as the portal for you
to access Pentaho tools and features. Home contains easy access buttons so that you can Browse Files, Create
New reports and dashboards, view Pentaho Documentation, and quickly open recently viewed or favorite
files.
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[tem Name Function

Home indicator Indicates the current User Console perspective that you are using. The
o Home menu lets you flip easily from page to page, or return to your
Home page.
Getting Started Displays some resources to help you get familiar with the User
o Console. The Welcome tab shows an introductory video about

Pentaho products. The Samples tab holds a variety of small sample
reports and dashboards that you can use to get familiar with the
software. The Tutorials tab contains a number of tutorial videos that
give you a visual guide to the software.

Current User Shows the name of the person currently logged in to the User
o Console. Clicking the arrow next to the name lets you log out of the
User Console.

Browse Files Brings you to the Browse Files window, where you can locate your
o files using the Browsing and Files panes, and manage them using the
Actions pane.

Create New Gives you the option to create a new Interactive Report, Analyzer
e Report, or Dashboard. If you have permissions to work with Data
Sources, this button also gives you the option to create a new Data
Source.

Documentation Leads you to the Pentaho InfoCenter, which stores the documentation
o for Pentaho products.
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ltem Name Function

Recents Shows a list of your most recently opened files. Clicking on the star
o next to a recently opened file adds it to your Favorites list.
Favorites Shows a list of your favorite files for quick access.

Browse Files
The Browse Files page helps you keep your files and folders organized and makes them easier for you to find

and work with.
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ltem Name Function

Browse Files indicator  Indicates the current User Console perspective that you are using.
o Browse Files shows you how to locate your files and folders and the
different actions you can do with them.

Displays a series of three panes: the Browsing, Files, and Actions

panes.

Folders Shows a list of folders that you can browse through to locate your

o files.
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ltem Name Function

You can also use the Browsing pane to create new folders or delete
old ones.

After you select something in the Browsing pane, the Actions pane

populates with a list of things you can do with the folders.

Files Generates and shows a list of all files contained in the folder that is
o selected in the Browsing pane.
After you select a file, the Actions pane populates with a list of things

you can do with the file.

File Actions
o Shows a list of different things that you can do with the selected folder

or file.
The Actions pane gives you the ability to:
= Quickly open files in the current window or in a new one
= Run files in the background
= Edit, delete, cut, copy, or paste files or folders
= Share files with others
= Schedule reports to run automatically
= Add files to your Favorites widget
= View the Properties of a file or folder

Opened

The Opened page activates after you open a file from the Browse Files page and provides a simple space to

work with your files.
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Item Name
Opened indicator
Open...

New Interactive,
Analyzer, Dashboard,

or Data Source

Edit, Save, and Save

o As

Report Window

(3

Schedules

Function

Indicates the current User Console perspective that you are using.
Opened displays the files that you access from the Browse Files pane.

» Open... serves as a quick way to browse for more files to open without
leaving the Opened page. These additional files open in new tabs
across the Report Window.

= Quick start buttons to create a new Interactive or Analyzer,

Dashboards. You can also use this button to create a new Data
Source, if you have permissions to work with data sources.

Gives you the ability to perform these functions on the active file in the
Report Window: edit, save the file with a default name in the same
location, or save the file with a different name and in any location on
the repository or your desktop

Displays the file or report that is currently opened, and lets you edit or
work with the file.

You can schedule reports to run automatically. All of your active scheduled reports appear in the list of

schedules, which you can get to by clicking the Home drop-down menu, then the Schedules link, in the upper-

left corner of the User Console page. You can also access the list of schedules from the Browse Files page, if

you have a report selected.
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The list of schedules shows which reports are scheduled to run, the recurrence pattern for the schedule, when
it was last run, when it is set to run again, and the current state of the schedule.

Item Name Function
Schedules indicator Indicates the current User Console perspective that you are using.
o Schedules displays a list of schedules that you create, a toolbar to

work with your schedules, and a list of times that your schedules are
blocked from running.

Schedule Name Lists your schedules by the name you assign to them. Click the arrow
o next to Schedule Name to sort schedules alphabetically in ascending
or descending order.
o Repeats Describes how often the schedule is set to run.
o Source File Displays the name of the file associated with the schedule.
o Output Location Shows the location that the scheduled report is saved.
G Last Run Shows the last time and date when the schedule was run.
o Next Run Shows the next time and date when the schedule will run again.
Status Indicates the current Status of the schedule. The state can be either
o Normal or Paused.
o Blockout Times Lists the times that all schedules are blocked from running.
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You can edit and maintain each of your schedules by using the controls above the schedules list, on the right

end of the toolbar.

Icon Name

Refresh

Q

Run Now

D

Stop Scheduled Task

Start Scheduled Task

Edit Scheduled Task

Z
Remove Scheduled
H Task
Themes

Function

Refreshes the list of schedules.

Runs a selected schedule(s) at will.

Pauses a specified schedule. Use Start Schedule to start paused jobs.

Resumes a previously stopped schedule.

Edits the details of an existing schedule.

Deletes a specified schedule. If the schedule is currently running, it
continues to run, but it will not run again.

The User Console has two themes built in, called Crystal and Onyx. The default display shows the Crystal

theme, but if you prefer, you can change the theme so the console displays the Onyx theme.

1. From any page of the User Console, click View in the upper-left menu bar.

2. Select Themes, then Onyx, from the drop-down menu.
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Getting Started with the Pentaho User Consaole

Favorites
=

Y

The Home page refreshes and appears with the Onyx theme.

Tools

The User Console has three main tools. This table helps you decide what tools best fit for your needs and

provides links to the corresponding articles.

Explore
Considerations

Summary

Expertise

Time

Recommendation

Interactive Reports

Interactive Reports is a
web-based design
interface which is used to
create both simple and on-
demand operational
reports without depending
on IT or report developers.

Basic computer skills and
knowledge of web
browsers.

Approximately 30 minutes.

Use Interactive Reports to
create operational or

https://help.pentaho.com/Documentation/5.2/0L0/120/000
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Choose Options

Analyzer Reports

Analyzer Reports is an
analytical visualization tool
that filters and drills down
into business information
contained in Pentaho
Analysis data sources.

Basic computer skills,
knowledge of web
browsers, familiarity with
data structures.

Approximately 30 to 60
minutes.

Use Analyzer Reports to
perform advanced sorting

Dashboard Designer

Dashboard Designer
allows users to create
dashboards with little or
no training. The dashboard
is several different reports
brought together inside
one screen.

Basic computer skills and
knowledge of web
browsers.

Approximately 30 minutes.

Use Dashboard Designer if
you want to create an
interface to view multiple
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Explore
Considerations

Interactive Reports

financial reports, create
reports that provide you
with significant control
over formatting elements
such as fonts, background
color, and column widths
and sorting.
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Choose Options
Analyzer Reports

and filtering of your data,
create drill through reports
to access underlying data,
view chart visualizations, or
to analyze business data
quickly in a dynamic

environment.

Dashboard Designer

reports at once, view
charts and graphs within
one space while you create
reports in another, and
have quick access to web
pages that you visit often.
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Use Pentaho Interactive Reporting

The intuitive, drag-and-drop, web-based design environment for Interactive Reports enables you to quickly add
elements to your report and format them any way you like. You do need any special expertise to use
Interactive Reports. You can display Interactive Reports in a dashboard in the User Console.

Here is a list of the main Interactive Report features.

= Font selection

= Column resizing

= Column sorting

= Ability to rename column headers

= Copy and paste functionality

= Unlimited undo and redo functionality

= Ability to output reports as HTML, PDF, CSV, or Excel files
= Ability to display reports in a dashboard

Before you can create an Interactive Report, you must have access to a data source. Only system
administrators can create data sources. The data source for an Interactive Report is based on the Pentaho
relational data model, also known as the metadata data model. The metadata data model enables the Pentaho
system to present data in reports in meaningful business terms instead of in abstract terms. For example, a
table referred to as CUST_TBLE or ORDR_TBLE in the data model can be presented in a report as Customers

and Orders.
Note: All graphics displayed in this section show the Onyx theme.

+ Create an Interactive Report

+ Filter Reports

+ Disable Auto Refresh Mode in Interactive Reports
+ Enable Row Limits and Query Timeouts

+ Refine Your Interactive Report

+ Format Interactive Reports

+ Edit Interactive Reports

* Interactive Reports and Report Designer

* Read an Interactive Report in View-Only Mode

+ Interactive Reporting Quick Reference
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Create an Interactive Report

Creating Interactive reports is easy to do from the Home page of the User Console. Interactive reports are built
by clicking and dragging fields from your data source and on to a report canvas. You can see the report take
shape as you drag fields to the canvas, and you can change the layout and format of the report as you go

along.

These steps guide you through making an Interactive report.

1. From User Console Home, click Create New, then Interactive Report.

2. Choose a data source for the report from the Select Data Source dialog box. Click Ok. If no data source
is listed in the dialog box, contact your administrator for help.

3. To add your first column, click and drag a field from the Data tab in the left pane. Drag the field over
the report canvas on the right until a vertical green line appears, then drop the field in place. The field
becomes a column in your report.

4. Continue to drag and drop fields on to the report canvas until you have all the columns of your report
in place.

NOTE:

You can rearrange the order of the columns by clicking on the headers and dragging the columns to the
right or left of their current location. When a green line appears, you can drop the column there. You
can also resize your columns by selecting the bar to the right or left of the column header and dragging
it until your columns are the correct size.

5. Click Save As. Type a file name for your report and choose a location to save it in.

The new Interactive report is created and saved in a location of your choice. Please keep your new report open
and go to the next section if you want to learn to group data in your Interactive report.

Group Data in Your New Interactive Report

You can organize the data in your Interactive reports by grouping it in different fields, such as geographic
region, product line, or both. After you get your data organized into groups, you can sort the data by clicking on

the arrows that appear next to the group names.

1. If the field you want to group by is already a column in your report, click the column header and drag it
up above the other headers in your report. Release the mouse button once the horizontal green line
appears.

2. Ifthefield is not already a column in your report, drag it from the Data tab in the left pane. Drop the
field in the space above the report headers.

3. Ifyou want to group data by more than one field, you can nest it into a group by dragging the field or
column header beneath the original group.

4. Click Save.
The data is grouped and organized in your Interactive report.
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Filter Reports

Filters restrict or limit the data that is presented in a report. For instance, you can filter data to limit sales
figures to the first quarter of the year. Interactive Reporting allows you to use several different methods to
filter data.

+ Add Filters to an Interactive Report
+ Apply a Summary Function
« Apply an Aggregate Function

+ Flag a Filter Constraint for Use as a Dashboard Parameter
* Add a Filter on Date Fields
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Add Filters to an Interactive Report

Filters are used to restrict or limit data in a report, building the report to show only the information that you

want to view.

For example, a typical report shows sales by product line. A time filter on Quarter restricts the data so that only

sales for the one quarter are shown.

If you add a regional filter for Europe, the report would display data pertaining to European sales for that
quarter. If you add a filter on another field to exclude a product, the report would display data pertaining to

European sales in that quarter, which are also not a part of the excluded product line.
These steps describe how to add filters to an Interactive report.

Login to the User Console, and click Browse Files to browse to the location of your Interactive report.

2. Open the report. Click the blue plus sign next to No Filters on the toolbar near the top of the report. A
workspace for filters appears at the top of the report.

3. From the Available Fields panel, drag fields into the Filter Panel. The Filter dialog box appears. Notice
that the values associated with the field are listed in the dialog box. You can choose one of these
values, or you can enable Match a specific string to filter the report on a specific string of data.

4. Select the value or values that you want from the Add Selected list and click the arrow to move it into
the right pane. The value appears with a green check mark next to it in the right pane.

After you have selected all of the values that you need from the list, click OK to exit the dialog box.

Repeat this process for each field that you want to filter on. The Interactive report displays data for the
chosen values only.

7. Save your report.
The Interactive report is filtered and saved. You can click Undo or Reset to return to the previous version of the
report.

« Create Advanced Filters
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Create Advanced Filters

You can create filters on multiple groups of fields, rather than a single group of fields. Filters with multiple
groups are called advanced filters. To create an advanced filter, drag the fields into the Filter Panel and move

items into multiple groups by moving them up, down, and indenting them to create a hierarchy.

This example shows how to use a sample database for the purpose of providing a guide to follow. It uses the
Order database, which is part of the Steel-Wheels sample data, to build a filter that shows all orders that are
less than $500,000 in North American and are greater than $300,000 in EMEA.

Tarkory Exactly matches EMEA -
R | Totel (Sum) Greater Than 300000 «

Temiory Exactly matches NA ~

Total (Sum) Lass Than 500000 -

((Tarrkory Exactly matches EMES AND Total (Sum) Greater Than 300000) OR {Teritory Exactly matches NA AND Tatal (5um) Less Than 500000])

Follow these steps to create an advanced filter using the filter created in Add Filters to an Interactive Report.

Click the down-arrow on Total (Sum) Less Than 500000 and choose Indent.

Click the down-arrow on Territory Exactly matches NA and choose Move Down.
Click the down-arrow on Total (Sum) Greater Than 300000 and choose Indent.
Click the down-arrow on Territory Exactly matches EMEA and choose Move Down.
Click the down-arrow on the left AND/OR drop-down and choose OR.

Click Apply Now to apply the filter to your data.

AN AN o e

The workspace shows data that either has a Total sum that is less than 500,000 in North America or a
Total sum greater than 300,000 in EMEA.
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Apply a Summary Function

You can assign a summary function to columns that contain numeric values in your report. A summary
function is a summarization technique that performs calculations on values in columns, groups, or in the entire

report.

1. Click the down arrow next to a report column that contains numeric values.

2. Select Summary from the menu, then choose the summary type.

Function Name Description
None No summary function assigned
Average Calculates the average value in a given column
Count Counts the items in a group or report, but does not

require a numeric value.

Count Distinct Counts the distinct occurrences of a certain value in a
column; does not require a numeric value

Max Identifies the highest or largest value in a column
Min Identifies the lowest or smallest value in a column
Sum Calculates a total sum of the group or report (group

level, and running total in the report footer)

The numeric values in the column update.

3. Save the report.
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Apply an Aggregate Function

You can assign an aggregate function to columns that contain numeric and non-numeric values in your report.

Aggregate functions return a single value (for example, Average, Maximum, Minimum), calculated from the

values in a column. For example, the sum of a column results from adding all the values in the column.

1. Click the down arrow next to a report column that contains numeric values.

2. Select Aggregation from the menu, then choose the aggregation type.

Function Name
None
Average

Count

Count Distinct

Max
Min

Sum

The values in the column update.

3. Save the report.

https://help.pentaho.com/Documentation/5.2/0L0/120/020/010/020
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Description
No aggregate function assigned
Calculates the average value in a given column

Counts the items in a column; does not require a
numeric value

Counts the distinct occurrences of a certain value in a
column; does not require a numeric value

Identifies the highest or largest value in a column
Identifies the lowest or smallest value in a column

Calculates a running total sum of the specified column
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Flagging a Filter Constraint for Use as a Dashboard
Parameter

You can flag a filter constraint for as a parameter. The parameter name will appear on the Parameters tab in
Dashboard Designer when you place the report into a dashboard panel. You can also edit parameters while
working in Report Designer.

1. After you create your filter, enter the parameter name in the Parameter Name text box.
2. Click OK.

3. Save your report.

The parameter is ready to be used in Dashboard Designer. To see if the parameter appears in Dashboard

Designer, insert your report into a dashboard panel. The parameter name will appear on the Parameters tab.
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Add a Filter on Date Fields

Use these steps to add a filter that matches a specific value.

In the toolbar, click Filters. The Filters Panel appears above the report.
Click and drag a date field from the right pane into the Filters area. The Filters dialog box opens.

Next to the field name, choose a date constraint from the list, then click the small arrow on the right to
display the date picker. To create a "date range" you must add two filters: one for the start date, and
one for the end date.

4. In the date picker choose your date.

5. Click OK to save your filter.
The report display updates as soon as the filter is added. The filter appears in the Filter box and an icon
displays next to the field name in the Data tab. Also, the number of filters added to the report appears next to
the filter icon in the toolbar.

You can edit the filter by clicking Edit. You can delete the filter by clicking the delete button.
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Disable Auto Refresh Mode in Interactive Reports

When you disable the Auto Refresh mode in Interactive Report you can design your report layout first,
including calculations and filtering, without querying the database until you are done. When the report layout
is complete, you can re-enable Auto Refresh mode. Data retrieval occurs once, and your report displays the
requested data. Disable auto refresh if you want to reduce the number of queries executed against the data

source, or if you know that the data source returns data slowly.

To disable Auto Refresh, click the small icon in the upper-right corner of the Data tab to open the Query Setup
dialog box, then disable the Auto Refresh option.
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Enable Row Limits and Query Timeouts

You can limit the number of rows that are displayed in your report. You can also limit the number of seconds a
query runs before a timeout occurs. Imposing row limits and timeouts on queries is important to avoid out-of-
memory errors, or processes that consume too many resources on the database server.

Both options are available in the Query Setup dialog box. In the Data tab, click the small icon in the upper-right
corner to open the Query Setup dialog box. Make changes as needed and close the dialog box when you are
done.

Define Result Row Limit and Timeout has information about refining the row limits and timeouts further with
Metadata Editor.
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Refine Your Report

Now that you have defined the data for your report, you are ready to begin refining some of the formatting

elements in your report.

See the Interactive Reporting Quick Reference section for an overview of formatting actions.

+ Edit Report Headers and Footers
+ Edit the Report Title
+ Reorder and Adjust Columns
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Edit Report Headers and Footers

To create the page headers, double-click the upper-left or upper-right corner of the report.

A pop-up dialog box appears. You can:

= Delete any existing words, or enter a new header and press <ENTER>.

» Click Date and press <ENTER> to insert a date and time stamp in the page header. You can customize the date
and page count by adding your own text, such as, Today: $(report.date), instead of using the default,
$(report.date).

» Click #/Pages and press <ENTER> to insert the number of pages in the report, as in 1/1 (page one of one).

Repeat this process for the page footers, at bottom-left and bottom-right.
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Edit the Report Title

To edit the report title, double-click Untitled; a pop-up dialog box appears. Enter a title for your report in the
text box; then press <ENTER>.
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Reorder and Adjust Columns

To change the order of columns in your report, choose the column you want to move, then drag it to the

desired location. Alternatively, choose the column you want to move, click the down-arrow, and choose Move
(Left or Right) from the menu.

To adjust a column's width, choose the column, then click the vertical line that divides the column headers.
Move the line left or right to adjust the column width.
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Format Interactive Reports

You can use the Formatting tab in the left pane to change the appearance of your report, including font color,
size, text alignment, background color options, and more.

+ Change the Report Template

+ Change Page Format and Orientation
+ Change a Column Header Name

+ Apply Copy/Paste Formatting

+ Change the Format of Numeric Values
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Change the Report Template

To change a report template, click the General tab, then use the left and right arrows to page through available
templates. Click Select to see all templates.

If you decide to change the report template, answer Yes or No when you are prompted whether to keep that

formatting change. The report display is updated to reflect the new template.
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Change Page Format and Orientation

By default, Interactive Report creates a portrait mode page in Letter format (8.5" x 11"), a format used in the

United States. You may need to change the page orientation or format.

To change page orientation, click the General tab, then click Page Setup. In the Page Setup dialog box, click the

appropriate icon. Click OK to save your changes.

To change page format, click the General tab, then click Page Setup. In the Page Setup dialog box, choose the
correct page format for your report. Page margin measurements are displayed in the lower part of the dialog

box. You can adjust the measurements as needed. Click OK to save your changes.
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Change a Column Header Name

To change a column header name, double-click the column header; a pop-up dialog box appears. Enter the
new header name and press <Enter>.
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Applying Copy/Paste Formatting

You can use the Copy formatting/Paste formatting options on the Formatting tab to copy column formatting
to other columns in your report.

Select the column that contains the formatting you want to copy, then click Copy Formatting. Select the

column to which you want to apply that format and click Paste Formatting.
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Change the Format of Numeric Values

If your column contains numeric values, you may need to change the formatting associated with those values.
Click inside the column you want to format, so it appears selected. Click the Formatting tab, then choose the
appropriate format for the values in your column.

In some instances, you might notice that your numeric values have already been formatted. For example,

money symbols are already included in sales figures. Such formatting is inherited from metadata associated

with the data source. However, you can override inherited formats whenever you want.
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Edit Interactive Reports

Use these steps to edit your interactive report.

Login to the User Console and click Browse Files to locate the folder containing your report.

2. Right-click the report name and choose Edit. Alternatively, double-click the report name to open it, then
click Edit in the User Console toolbar.

3. Edit your report as needed.

Save your report.
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Interactive Reports and Report Designer

You can customize interactive reports even more by using Report Designer, the most comprehensive report
design tool in the Business Analytics software market. In addition to providing advanced formatting
capabilities, Report Designer lets you connect to disparate data sources. Charts and other report elements,

including sub-reports, can be added to a basic report. Report Designer lets you:

= Connect to diverse data sources from Pentaho Data Integration transformations, including relational data,
analysis, metadata, flat files, java objects, or stream data

= Create and view user prompts, including dynamic cascading prompts

= Add data visualizations such as charts, barcodes, sparklines, survey scales, and more
= Localize reports easily to support multi-lingual deployment with a single report file

= Embed HTML and JavaScript controls for dynamic and interactive online reports

= Fine-tune reports using the built-in interactive preview mode

Important: After you customize an Interactive Report using Report Designer, you can no longer edit the report

using the Interactive Reporting module in the User Console.

Interactive Reports are saved as .prpti files. Report Designer report files have a .prpt extension. In the User
Console, Interactive Reports are displayed with a special icon that differentiates them from reports that are
created in Report Designer.

If you want to create a new Interactive Reporting template, you must create it in Report Designer and place the

template in the Interactive Reporting templates directory.

For more information about enhancing Interactive Reports and building Interactive Reporting templates in

Report Designer, refer to the section Design Print-Quality Reports.
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Read an Interactive Report in View-Only Mode

After you save your interactive report, browse for it in your BA repository. You can quickly identify an
Interactive Report by its icon. When the report appears, notice the toolbar that allows you to perform certain
actions on the report. Hover your mouse over the icons in the toolbar to see which actions you can take. These

actions include, but are not limited to...

= Exporting a report as a PDF, HTML, Excel, or CSV file to be saved locally

= Adding filters for viewing report data

= Rearranging the report layout, such as moving, sorting, and removing columns from the report
= Editing page headers and footers

= Editing the report title

You cannot save any changes to your report when you are in View-only model. However, you can click Edit in
the User Console toolbar to return to edit mode and save your changes.
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Interactive Reporting Quick Reference

General

Action
To hide tips on startup...
To show tips on startup...
To hide tips altogether...
To disable menu buttons...

To enable menu buttons
(down arrow next to a
report column)...

To enable Select Distinct...

To export a report...

Description
Disable Show tips on startup in Preferences on the General tab.
Enable Show tips on startup in Preferences on the General tab.
Click Hide Tips in Preferences on the General tab.
Disable Enable menu buttons in Preferences on the General tab.

Click Enable menu buttons in Preferences on the General tab.

Click the Query Setup icon in the Data tab to prevent the report from displaying
duplicate values in columns. Enabling this option will list different (distinct) values in a
table.

Click Export and choose your export file type: PDF, Excel, CSV or HTML. You can save
exported files on your computer.

Fields and Columns

Action

To place a field on the report
canvas...

To place multiple fields on
the report canvas...

To move columns left or
right...

Description

Click and drag a field from the right pane to the report canvas. Alternatively, double-
click a field name to place it on the report canvas.

For quick placement, click Layout in the toolbar and drag the fields into the

Columns area. Alternatively, right-click a field name and choose Column.
Press the <CTRL> key and choose multiple fields in the right pane, then drag the fields

onto the report canvas. The fields will become columns in the report in the order in
which they were selected.

Click the report header and move the column to the desired location. Right-click the
column header and choose Move > Right (or Left).

You can also move columns as needed by clicking the Layout button in the
toolbar and dragging the columns to the desired position.
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Action Description

To adjust column width... Click the column header to choose it. Move your cursor to the right or left until a small
horizontal line appears. Drag the line to the desired width.

To assign column width Enter a value in the Column Width text box on the Formatting tab.

(percentage)

To change the column Double-click the column name and enter the new name in the available text box.
name...

To remove a column... Click and drag the column header to the right and place the column into the trash can.

Grouping

Action Description

To add a group to areport...  Click and drag a group field from the right pane up above the column headers in the
report. Release the mouse button when the green horizontal line appears.

If the group field you want is a column in the report, drag the column name
above the column headers in the report. Release the mouse button when the
green horizontal line appears.

For quick placement, click the Layout button and drag the fields into the
Groups area. Alternatively, right-click the field name you want as your group

and choose Group.

To add more than one Click another group field from the right pane and drag it above or below the previously
group to a report... placed group.

To change the sort order of Click the small arrow to the right of the group name to change the sort order. Assign the
a group... sort order under Group Sorting in the right pane

Filtering

Action Description

To add afilter... Click Filters in the toolbar, then drag a field into the Filter area. Right-click the field
name you want to filter on (on the Data tab), and choose Filter. Select column name,
click to open the context menu, and choose Filter.

To edit a filter... Click the Edit icon next to the filter name to open the Filter dialog box. Make your
changes and click OK. Or you can choose a column name, click to open the context
menu, and choose Filter.

To delete afilter... Click Filters in the toolbar, then click the Delete icon next to the filter name.
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Action

To choose a filter value from

a list...

To find a filter value in a
list...

To include or exclude a filter

value from a list...
To specify a specific filter
value...

To create an advanced
query ...

Formatting

Action

To undo or redo previous
actions...

To change the font type a
column header...

To change font type the
column details...

To change font colorin a
column header...

To change the font color in
column details

To change the column

header background color...

To change the column
details background color...

To apply text justification...

https://help.pentaho.com/Documentation/5.2/0L0/120/020/090

Description

Click Select from list in the Filter dialog box.

Enter the first few characters of the value and click Find. Entries are case-sensitive.

Click either the Includes or Excludes link next to Select from list.

Alternatively, make a selection next to Currently in the Filter dialog box.

Click Match a specific value, then choose a constraint from the list.

Within the Filter Pane, click the Advanced Filter button in the bottom-right corner.
Enter an MQL query.

Description

Within the toolbar, click the green left-pointing arrow to Undo, or the green right-
pointing arrow to Redo.

Select the column header. Under the Formatting tab, choose font type from the
available list.

Select the column details. Under the Formatting tab, choose font type from the
available list.

Select column header. Under the Formatting tab, click the text color icon to choose
font color from the available list.

Select column details. Under the Formatting tab, click (icon here) to choose font color
from the available list.

Select the column header. Under the Formatting tab, click the Background Color
bucket icon. Select a color from the color picker, or create your own custom color.

Select column details. Under the Formatting tab, click the Background Color bucket
icon. Select a color from the color picker, or create your own custom color.

Select the report element column header or column details. Under the Formatting tab,
click the appropriate text alignment option. Column headers can be formatted
separately from column details.
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Use Pentaho Analyzer

Analyzer has an easy to use, web-based, drag-and-drop design environment that can be used by anyone who
wants to dynamically explore data and drill down to discover previously hiddent details. You do need any

special expertise to user Analyzer. You can display Analyzer reports in a dashboard in the User Console.

Before you can use Analyzer, you must have access to a data source. Only system administrators can create
data sources. The data source for Analyzer is based on the Mondrian multidimensional data model. The

Mondrian data model enables you to choose which dimensions and measures you want to explore in your
data.

+ Create a New Analyzer Report

https://help.pentaho.com/Documentation/5.2/0L0/120/030
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Create a New Analyzer Report

Creating an Analyzer report allows you to easily compare data, such as the actual versus budgeted expenses

by region for each of your departments, or the amount of sales by region.

Analyzer automatically fetches data in real time as you add and remove fields, so you may find it easier to

build a report with the Auto Refresh feature turned off. This lets you design your report layout first, including

calculations and filtering, without querying the database automatically after each change. Just click the auto

refresh icon in the tool bar to toggle Auto Refresh On or Off, or you can click the Refresh Report button at any

time.

7.

From User Console Home, click Create New, then Analysis Report.
Choose a data source for the report from the Select Data Source dialog box. Click Ok.

From the Available Fields pane on the left, click and drag an object to the Rows or Columns area in the
Layout panel. The data row or column appears in the table workspace.

In the list of fields, click and drag a measure to the Measures area in the Layout pane. The measure
appears as a column in the table workspace.

If you want to rename or reformat your columns, right-click a column and choose Column Name and
Format from the menu. The Edit Column window appears. You can also sort the data in your columns
by clicking and choosing a sort-order from the drop-down menu.

Choose a format from the Format drop-down box, or choose a visualization from the drop-down
menu. Click to refresh the report if you need to, then click OK.

Click Save As. Type a file name for your report and choose a location to save it in, then click OK.

The new Analyzer report is created and saved in a location of your choice.
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Visualizations for Analyzer

After you have created an analysis report, you will most likely want to make the report more visually pleasing
and meaningful for your audience. Analyzer has quite a few built-in visualizations that give you an effective
means for presenting your data in a way that people can intuitively understand. We also give you many

different ways to customize your visualizations.

Both the Layout and Property panels in the Analyzer workspace dynamically change based on the visualization
that you currently have selected. The Layout panel shows you what data is needed for that particular
visualization, and the Property panel lets you add or change options such as data labels, color patterns, or
bullet styles.

The optional properties for each visualization type are listed in each section. You can use any or all of these
properties for each visualization to make your report more intuitive for your audience. The Chart Options

dialog contains more ways to customize your reports.

Column and Bar Charts

Column and bar charts are among the most recognizable visualizations for data. Column charts display their
data vertically, while bar charts display the same data horizontally.
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Column and bar charts are good for just about every kind of data; however, they tend to work best when you
do not have a large number of variables to display. Drilling down into your data is easy: just double-click on a
column or bar in the report.
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Optional Properties for Column and Bar Charts

Definition

Use this to label the data features
of your report with what is
represented. You can also choose
no Data Labels, or specify where
you want them to appear.

Use this to put data labels on
your columns or lines, or both.

Shows a trend type of none or
linear. If you choose linear, you
can name your trend line and set
the width of it.

Line and Area Charts

Line and area chart visualizations show data on a graph by connecting plotted points with a line. Each point

represents a single value in your data. You can drill-down in both chart types by double-clicking on a data

point.

Available In:

all Column and Bar charts

Column/Line Combo charts

Column charts

A line chart shows just the line connecting the dots on the graph and works well if you have a large amount of

data to analyze.
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An area chart shows an aggregate of your data and helps you spot trends quickly, by showing totals and how

they are moving relative to each other.
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Both types of chart are good if you want to identify trends that happen over a period of time, such as for

financial growth, real estate sales, or test scores.

Optional Properties for Line and Area Charts

Property

Data Labels

Bullet Style

Line Width

Trend Type

Definition

Use this to label the data features
of your report with what is
represented. You can also choose
no Data Labels, or specify where
you want them to appear.

Choose the shape that you want
to use for your bullets.

Specify the width lines on your
report.

Shows a trend type of none or
linear. If you choose linear, you
can name your trend line and set
the width of it.

Pie and Sunburst Charts

Pie charts are round representations of your data, cut into slices. Each slice represents a piece of data, and the
size of the slice is proportionate to the data that it represents. Double-clicking on a slice lets you drill down into

your data.

Pie charts are a great way to show numerical or financial data, in other words, what something is worth relative

to the whole group.
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Sunburst visualizations organize and display your data in a series of colorful rings. Starting with the center ring,
each ring going outward represents more detailed information relating to the inner ring to which it is

connected. These outer rings are arranged and colored to indicate their hierarchical relationship with the inner
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ring. Any fields that contain empty slices can be shown as gaps in the Sunburst.

You can drill-down into your data by double-clicking on a data slice. The Sunburst then rearranges itself to

show the more detailed information.

Sunburst visualizations are particularly well-suited for numerical analysis of hierarchical data.
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Optional Properties for Pie and Sunburst Charts
Property Definition Available In:
Use this to label the data features
of your report with what is
Data Labels represented. You can also choose = Pie and Sunburst charts

no Data Labels, or specify where
you want them to appear.

Order B Allows you to decide how to sort
y your data on the report.
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Property Definition Available In:

Check this box to show Empty

Empty Slices box Slices as gaps in the report.

Sunburst charts

Scatter Chart Visualization

Scatter charts are related to line and area charts, but show the intersection of x and y values at each data point.
These values appear on the scatter chart as a series of bubbles on a graph, based on the attributes you used
when you built your report. You can then use a measure to color-code the bubble or use a measure to specify
the size of the bubble. Drilling-down is accomplished by double-clicking on any data point on the chart.

Scatter charts work well to show the categorical relationship between two sets of numerical measures, such as

between a budgeted amount and the actual amount of money spent.
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Optional Properties for Scatter Chart Visualization
Property Definition Available In:

Use this to label the data features
of your report with what is
Data Labels represented. You can also choose  Scatter chart visualization
no Data Labels, or specify where
you want them to appear.

Shows a trend type of none or
linear. If you choose linear, you

Trend Type . Scatter chart visualization
can name your trend line and set
the width of it.
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Heat Grid Visualization

Heat Grids give you the ability to visualize data so you can identify patterns of performance. This visualization
type will color-code your results so you view complex business analysis in an easy-to-understand way. Drill-
down in your data by double-clicking any square on the grid. Heat Grids are especially well-suited for

comparing categorical data using color.
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Optional Properties for Heat Grid Visualization

Property Definition Available In:

Use this to label the data features
of your report with what is
Data Labels represented. You can also choose  Heat Grid visualization
no Data Labels, or specify where
you want them to appear.

Lets you choose from Gradient, 3

Step, or 5 Step patterns. Heat Grid visualization

Pattern

Choose from different mixes of

Heat Grid visualization
colors for your report.

Color

Reverses the order of colors in

Heat Grid visualization
the report.

Reverse Colors box

Choose the shape that you want

Heat Grid visualization
to use for your bullets.

Bullet Style
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Geo Map Visualization

Geo maps show a geographic summary of your data using size and color. This visualization type plots a pin on
a map, based on the location attribute you used. You can add a measure to specify the size of the pinpoints,
then use the properties panel to change the color of the pinpoints. Double-clicking on a pinpoint drills-down
into your data. If your data model has geographic annotations, then the location information will be retrieved

by the geoservice automatically. Geo maps are especially useful for retail or sales data.

You must have a license from Google if you choose to use Google Maps with Pentaho software for an internal

BA deployment.
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Optional Properties for Geo Map Visualization
Property Definition Available In:
Pattern Iéféspygtlsclgseo;;;z?ngradlent, 3 Geo Map visualization
Color Choose from different mixes of Geo Map visualization

colors for your report.

Reverses the order of colors in

the report. Geo Map visualization

Reverse Colors box
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Chart Options for Analyzer Reports

The Chart Options dialog box is available if you have a visualization applied to your report. Just click on the

Chart Options button in the Properties panel to bring up the chart options for that report. You can click Apply

to update your report with your changes up to that point, and continue working with the Chart Options. After

you are done setting options for your chart, click OK, and the report will refresh to reflect the options.

General Tab

The General tab is where you can determine background colors, fonts, or set the domain limit for the

maximum number of plot values for your report.

Chart Options

Background:
Fill Type: Mane Zl

Labels:

Domain Limit:

Max Nurmber of Plot Values:| 100 ﬂ

Default El 12E| NormaIEl

General Tab Description

Option

Background:

Labels:

Domain Limit:

https://help.pentaho.com/Documentation/5.2/0L0/120/030/010
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Description

Fill type defines the background color of the chart
and the fill colors used.

Choose None, Solid, or Gradient with the dropdown

menu.

Use the dropdown menus to choose a font for your
data labels, specify the size and type for the font,
and change the font color with the color picker.

Max Number of Plot Values: Use this to set the

maximum number of plot values used in your
report.
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Axis Tab

The Axis tab is where you can define how the x-axis and y-axis appear on your report.

Chart Options

Primary Axis:

Auta Range

Scale: Mone [=]

Secondary Asas (Scatter and Column-Line Combao charts only):

[#] Auto Range Start: Srop:

Secale: Mone =]

Axis Tab Description

Option Description

Auto Range check box: Calculates the Start and
Stop value automatically. If you want to specify the
values, uncheck the box and fill out the Start and

Primary Axis: Stop fields.

Start: Use to set the starting value for the axis.

Stop: Use to set the stopping value for the axis.

. Increase the scale for the primary axis, or leave it set

Scale:

to a default of None.

Available for Scatter and Column-Line Combo charts

Secondary Axis: only. Secondary Axis has the same options as
Primary Axis.
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Legend Tab

The Legend tab has a few features that you can use to customize the look of the legend that goes along with
your report.

Chart Options
Genera Axis Legend Other
Show Legend
Pocitior: Eackground Color:
Right
Font:
Default [*] 12[¥] Nomal[¥]
Legend Tab Description
Option Description

Show Legend: Uncheck this box to remove the legend from your
report.
Position: Use the dropdown to move the legend to the Top,
’ Right, Bottom, or Left of your report.
Use this to change the background color of the
Background Color: legend. Click on the Background Color box to bring
up the color picker.

Use the dropdown menus to choose a font for your
Font: data labels, specify the size and type for the font,
and change the font color of the legend.
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Other Tab

The Other tab is where you go to tailor the look of the small charts for your report, if you have the Multi-Chart
option selected. You can alter the size of negative values, or specify how you want Analyzer to show empty

cells in your report.

Chart Options
Genera Adis Legend Other

Multi-Charts:
Charts Per Row: 3E|

Azis Auta Range for Charts: Same range forall [=]

Size By Measure:
Treat Negative Values as: SmallestValue [ =]

Empty Cell Treatment (Line and Area charts only):
Show Gap =]

Other Tab Description

Option Description

Charts Per Row: Chose from the dropdown to

specify how many multi-charts on each row appear.

Multi-Charts: Axis Auto Range for Charts: Use this to set the axis
range for your multi-charts. You can use the same
range for all of the small charts or set them
independently.

Size By Measure: Treat Negative Values as: Use the dropdown menu

y ) to choose either Smallest Value or Absolute.
Controls how empty cells appear in your Line and
Empty Cell Treatment (Line and Area Charts Only):  Area charts. Choose from Show Gap, Connect with
Dotted Line, or Treat as Zero.
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@ pentaho

Add Filters to an Analyzer Report

Filters are used to restrict or limit data in a report, building the report to show only the information that you

want to view.

For example, a typical report shows sales by product line. A time filter on Quarter restricts the data so that only

sales for the one quarter are shown.

If you add a regional filter for Europe, the report would display data pertaining to European sales for that
quarter. If you add a filter on another field to exclude a product, the report would display data pertaining to

European sales in that quarter, which are also not a part of the excluded product line.
Use these steps to add a filter to your Analyzer report.

1. Login to the User Console, and click Browse Files to browse to the location of your Analyzer report.

2. Open the report. Click blue plus sign next to No Filters on the toolbar near the top of the report. A
workspace for filters appears at the top of the report.

3. From the Data Source pane, click and drag a field or column into the filter workspace. The Filter dialog
box appears. Notice that the values associated with the field are listed in the dialog box. You can choose
one of these values, or you can enable Match a specific string to filter the report on a specific string of
data.

4, Select the value or values that you want from the Add Selected list and click the arrow to move it into
the right pane. The value appears with a green check mark next to it in the right pane.

5. After you have selected all of the values that you need from the list, click OK to exit the dialog box. Your
Analyzer report displays data for the chosen values only.

6. Save your report.

The Analyzer report is filtered and saved. You can click Undo or Reset to return to the previous version of the

report.

+ Create Date Range Filters
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Create Date Range Filters

Date range filters enable you to show only data that meets the conditions of the filter in a report. For example,
you can create filters to display data between 2010 and 2013, or all data after 2010. After you have applied
your filter, the Analyzer report shows only data specified by the date ranges that you selected.

1. Log in to the User Console, then open an existing analysis report that contains a time dimension or

choose Create New > New Analysis.

2. For a new report, select the data source that you want to use and click OK.

3. Create the report with a time dimension, such as year or quarter.

4. Click the icon to Add A Filter, then drag the time dimension that you want to filter on to the Filters
board. You can also right-clicking on the dimension and adding it as a filter.

5. Choose one of these radio buttons to create your filter:

+ Use Choose a commonly used time period to specify a time period such as Current Quarters or Same
Quarters last year or Calendar Month. Once you have your time period specified, click OK to apply the
filter. This filter is dynamic and changes with the current date. The other date filters are static.

Filter on Quarters &

Q) Choose a commonly used time period

! Select from a list (Includes, Excudes)

-/ Select a range (Between , After, Before)

:| Current Quarters

[] Previous Quarters

:| Mext Quarters

[7] Same Quarters last year
Z| Previous 4 Quarters

[] Next Quarters

:| Quarters ago

J Quarters ahead

_—| Parameter Name

+ Select from a list lets you choose values from a list. You can use the single right- or left- arrows to add or
subtract one value at a time, or use the double right- or left-arrows to add or subtract all of the values in
the list. Click OK to apply the filter to your report.

* If you choose Select a range, then click the Select from date picker link, you will be able to use the date
picker calendars to select beginning and ending dates for your report data. Click Apply, then OK, to apply
the filter to your report.
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Filter on Quarters

© Choase a commonly used time period

@) Select from a list (incluges, Excuges)

() Select a range (Between, After, Before)

Choose values from list:

Find

QTR1
QTR1
QTR1 >
QTR2 ¢
QTR2
qQTR2
QTR3
QTR3 »
QTR4

QTR «

Showing all 10 values

0 Parameter Name

Currentdy  Included [v]:

~ QTR1
« QTR2

2 values selected

OK

* Once you select a date, the data is validated to make sure that your date ranges actually contain that
date. Analyzer searches for the nearest time period, up to plus or minus 30 time periods, if no date is
found the first time. You will not be able to save the date filter if no dates are found.

Quarters is Between (and incl.)

Type a date into the fields or click the calendar icon to select specific date ranges.

Begin Date:
2003-01-01

January ~ >

S MTWTF S
30211 2 3 4 5
6 7 & 9 101112
13 14 15 16 17 18 19
20 21 22 23 24 25 26
27 28 29 3031 1 2
3 45 6 7 8 9

2012 2013 2014

NOTE:

When you create a date range filter using the Between (and incl.) operator and parameterize it, as described in
Add Query Parameters in Analyzer Reports, you specify one parameter name, but two parameters are created.

End Date:
2004-01-01

Apply Cancel

One parameter controls the start of the range, and another controls the end of the range. The start date

parameter is <YourParameterName>_START, and the end date parameter is <YourParameterName>_END.

The Choose a commonly used time period and the Between, After, Before filters are available only if time

dimension levels are set up with the AnalyzerDateFormat annotation.
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@ pentaho

Enable Drill-Through Links

You use drill-through links in Analyzer to view all individual records that make up an aggregate value in your
analysis report. This will turn all non-calculated number fields into links which, when clicked, bring up a
configurable data grid that enables you to quickly view more details for that data point, without having to
reconfigure your report. The drill-through grid shows all levels and non-calculated measures that are defined

in the report cube by default.

If needed, you can select the columns you want to show in the grid so that report designers only see the
selected columns. This is useful if your report cube contains many levels and measures and you want to show

only specific data for analysis.

Note: Drill-through links are not available for any calculated measures, including schema-defined calculated
measures and user-defined measures, such as Percentages, Running Sum, and Trend measures. Drill-through
links are also not available on sub-totalled cells.

The directions below guide you through the process of setting up drill-through links.

Open the Analyzer report to add drill-through links.

N

Click the More actions and options icon in the report toolbar, and select Report Options from the
drop-down menu. The Report Options dialog box appears.

Select the Show drill-through links on Measure cells check box.

Click the Select Columns link to choose the columns you want to appear.

Click OK. The measure fields in your report will turn into links.

Click a link in the report to see a data grid that shows all of the available details for that value.

N o v W

You can also add or remove columns from this grid, by clicking Select Columns at the top of the data
grid. You can also search and toggle the sort order in the same way as the Available Fields list.

a. Click to deselect the columns that you want to hide.

You now have drill-through links for numeric, non-calculated members. If you choose, you can later disable the
drill-through links by deselecting the Show drill-through links ... check box.

https://help.pentaho.com/Documentation/5.2/0L0/120/030/040 57/105
Updated: Tue, 30 Sep 2014 01:20:21 GMT



‘@ pentaho

Add Query Parameters to Analyzer Reports

You must be logged in to the User Console. Open the Analyzer report you created in Add Filters to an Analyzer
Report.

You can parameterize a query in Analyzer.

1. Drag and drop the dimension member you want to create a parameter for onto the Filters canvas.

2. Select the level you want to set as the default parameter value, then click the right arrow to move it to
the list on the right.

3. Click the check box at the bottom of the window, then enter a name for the parameter in the
Parameter Name field.

4. Click OK.

Your parameter is a filter in Analyzer. Whenever this Analyzer report is run, users will have a selection of

columns to filter by.

Passing the Parameter through a URL
After you have a parameter created, you can generate a URL to share with users. Just customize this sample

URL to reflect your server name, user, report name, and parameter.
http://localhost:8080/pentaho/api/repos/%3Ahome%3Aadmin%3AAnalyzerFiltered.

xanalyzer/editor?FYear START=2003&FYear END=2005

Filter on Years

" Choose a commanly used time period

' Select from a list (Includes, Excludes)

@ colecta range (Between , After, Before)

‘Years s Between (and incl) El 2003 Eland 2005 Elj:elac:trcm date picker

Parameter Name
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Define Hyperlinks

Presenting too much information in one report can overwhelm readers with distracting details, causing them
to miss information that is important to them. You can manage the amount of information displayed in a
report by hyperlinking from one report to other related reports, charts, dashboards, and URLs. For example,
you can present basic information in an easy-to-comprehend report with hyperlinks to reports that contain

details.

For charts, hyperlinks take precedence over the drill-down chart feature. For example, when readers click a bar
in a chart, it displays data related to the hyperlink you define, not the drill-down chart.

For reports, you can define a hyperlink on any row label or column header. When you define a hyperlink, the
link is applied to all members within the row or column. In this source report, hyperlinks have been defined for
the Positions row label and the Region column header. Notice how each of the row and column members have

a blue underlined hyperlink.

When defining hyperlinks to a destination report that has parameters, you can map row labels and column
headers in the source report to parameters in the destination report. This enables you to constrain the
hyperlink result to display only data for the mapped parameters. If you do not restrain the results, all of the
data appears and no filter applies.

For example, you can create a hyperlink in the source report for all the members in the Position row, and
constrain the displayed data to only that related to each position and its department. To do this, you map the
Department and Position row labels in the source report to the Business Unit and Job Title parameters in this

destination report.

Each parameter added to the mapping constrains the data further. You can map any row labels that appear to
the left, and column headers that appear above the member data.

Note: If you did not constrain the data with parameters, readers would see data for all Administrative Assistant
Positions in all Departments.

Create Hyperlinks to a Report in the BA Repository

Create an Analyzer report or open an existing one.
Right-click a row label or column header and select Hyperlink. The Link on dialog box appears.

Click Enable Link to activate the hyperlink feature. You can disable linking by clearing the Enable Link
check box.

In the Link To drop-down menu, select Pentaho Repository File.
Click Browse to locate a report, chart, or dashboard in the BA repository and click Open.

a. If the destination report has parameters, they automatically appear in the Destination
Parameter list on the left. Map parameters to related row labels or column headers by selecting
the check box for each parameter you want to use to constrain the resulting data. Enter the
related names of the row labels or column headers within curly brackets.
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b. If the destination report does not have parameters, the Destination Parameter list does not
appear. Go to the next step.

Specify how hyperlink content displays by clicking the Open in: drop-down menu and selecting New
Tab, New Window, or Current Window.

Enter a Tool Tip to be displayed when you hover over hyperlinks and click OK. Hyperlinks appear in the
Analyzer report.

Click the links to ensure the content associated with them appears correctly and save the report.

Hyperlinking to a URL

1.

Create an Analyzer report or open an existing one.
Right-click a row label or column header and select Hyperlink. The Link on dialog box appears.

Click Enable Link to activate the hyperlink feature. You can disable linking by clearing the Enable Link
check box.

In the Link To drop-down menu, choose URL from the dropdown menu.

In the URL field, enter the full web address you want the hyperlink to launch. For example,
http://www.yahoo.com.

Choose how the URL displays by clicking on the Open in:drop-down menu and selecting New Tab, New
Window, or Current Window.

Enter a Tool Tip to be displayed when you hover over hyperlinks and click OK. The new hyperlinks
appear in the Analyzer report.

Click the links to ensure the website associated with them appears correctly and save the report.
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Display Member Properties

When a number in parenthesis appears next to a dimension in a list of Available fields, that dimension is
associated with specific member properties. You can use those properties to constrain dimensions.

1. If you want to review available fields, click Add more fields onto the report on the report toolbar.

2. Locate a dimension in the Available fields list that includes a number in parenthesis. Examples:
Customer (6), Product (3)

3. Locate the corresponding dimension on your report. Right-click the row or column header for that
dimension, then click Show Properties. A menu displays member properties you can choose.

4. Select or clear the member property you want in the report, then click OK.

Your analyzer report is filtered by the choices you made.
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Simple Conditional Formatting of Measures

Conditional formatting in the Analyzer data grid means that cells will be physically affected by the data they
contain. The most common form of conditional formatting is stoplight reporting, where cell backgrounds are
colored red, green, or yellow depending on user-defined thresholds. Analyzer offers some simple pre-defined
methods of conditionally formatting numeric data. Follow the directions below to implement conditional cell
formatting.

1. Right-click a measure in the grid, then select Conditional Formatting from the context menu. A sub-

menu with conditional formatting types will appear.

2. Select your preferred number format from the list.

The analyzer report will refresh and apply the formatting choice you specified.

+ Conditional Formatting Types
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Conditional Formatting Types

Indicator Type Description

Color scale The background cell color will be shaded according to the
value of the cell relative to the highest and lowest
recorded values in that measure. There are several color
progressions to choose from.

Data bar The cell background is partially filled with a solid color
proportional to the scale of the cell's value relative to the
highest and lowest recorded values in that measure.

Trend arrow An upward or downward arrow is displayed to the right of
the cell value depending on whether it contains a positive
or negative value.
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Export an Analyzer Report

You can export a report as a PDF, XLSX, or CSV file.

1. In the Analyzer toolbar, click More actions and options > Export Report, and choose the desired output
format. The Export dialogue box appears.

2. If you export to a PDF, specify how you want the page formatted, then choose one of the following

options.
Option Description

Done Saves export settings, but does not export.

Export Applies options and generates output. If your report
includes a chart, it is included in the report, along with
the table view.

Cancel Discards all changes.

You must save the report if you want it to keep the export settings. Metadata for report author, source file

location, fields used and filter summary are included in the report.
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Use Dashboard Designer

Creating a dashboard in Dashboard Designer is as simple as choosing a layout template, theme, and the
content you want to display. In addition to displaying content generated from Interactive Reports and Analyzer,

Dashboard Designer can also include these content types.

= Charts: simple bar, line, area, pie, and dial charts created with Chart Designer
= Data Tables: tabular data
= URLs: Web sites that you want to display in a dashboard panel

Dashboard Designer has dynamic filter controls, which enable dashboard viewers to change a dashboard's
details by choosing different values from a drop-down list, and to control the content in one dashboard panel

by changing the options in another. This is known as content linking.
Note: All graphics displayed in this section show the Onyx theme.

+ Create a New Dashboard

+ Use Prompts on Dashboards

+ Dashboard Parameters

+ Use Content Linking to Create Interactive Dashboards
+ Add Content to a Dashboard Using Drag-and-Drop

+ Adjust White space in Dashboard Panels
+ Set the Refresh Interval
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Create a New Dashboard

You must be logged into the User Console. Use these steps to create a new dashboard.

From the User Console Home page, click Create New, then select Dashboard.

2. On the bottom of the page, click the Properties tab, and enter a title for your dashboard page in the
Page Title text box. The name you entered appears on the top left corner of the dashboard. This name
helps you identify the page if you want to edit, copy, or delete it later.

3. Click Templates to choose a dashboard layout. A blank dashboard with the layout you selected
appears.

4. Click Theme to choose a theme for your dashboard. The theme you selected is applied to your
dashboard.

You now have the basic framework for a Pentaho dashboard.

+ Work with the Chart Designer
+ Add Data to a Chart

* Work with Pie Charts

+ Work with Dial Charts

+ Correct Scaling Issues

+ Rotate Chart Axis Labels

+ Edit a Chart

+ Add a Data Table to a Dashboard

+ Update the Data Table Display
+ Add a Report Designer Report to a Dashboard

+ Add an Analyzer Report to a Dashboard
« Add a Web Site to a Dashboard

https://help.pentaho.com/Documentation/5.2/0L0/120/040/000 66/105
Updated: Tue, 30 Sep 2014 01:20:21 GMT



@ pentaho

Work with the Chart Designer

The Chart Designer allows you to create bar, pie, line, dial, and area charts that can be added to a dashboard.
Below are the general steps associated with creating a chart:

Select a data source.

Build a query.

Set the data definitions: values, series, category.
Select a chart type and theme.

Enter labels for the chart title, and x,y axes.

If applicable, adjust scaling and label rotation.
Place your chart in the dashboard.

© N o vk~ wWwN =

Save your dashboard.

If you are new to charting, here are guidelines that may help you determine what type of chart is best suited

for the data you want to present in your dashboard:

Bar Charts

If you want to compare items during a specific time period, consider using a bar chart. Key words to think
about when creating a bar chart are compare or rank. For example if you want to compare items sold to show
which one made the most profit, you might create a bar chart that ranks the products from the lowest to
highest profit. The bar's length determines its ranking; the label identifies the item. Bar chart data can be

presented horizontally or vertically depending on your requirements.

Pie Charts

If you are comparing parts of a whole, consider using a pie chart. Key words associated with charts include,
portion, share, and percentage. If for example, you want to demonstrate the proportion of the company's
budget spent on health insurance, use a pie chart. To make the chart easier to read, limit the number of slices
to five. Pie charts can also be exploded, which means certain slices are pulled away from the remainder of the
chart for emphasis.

Line Charts

Line charts are useful for showing changes over time. Key words associated with data that is best suited for a
line chart are trend, growth, and decline. If, for example, you want to show how product sales have changed
over five years, use a line chart. The slope of the line helps users quickly identify the direction of the trend.
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Dial Charts

Dial charts are often associated with Key Performance Indicators (KPIs). Dial charts are circular and contain a
scale, a needle, and one or more a dial sectors. The dial sector is used to identify a specified area on a dial
chart using a particular color. For example, you could have a dial plotting inventory with a minimum dial value
of 10000 and a maximum dial value of 50000. There could be a red dial sector for the region between 2000 and

4000 indicating that if the needle is in this area, there is a danger of a supply inventory shortage.

Area Charts

Area charts can be used to show a comparison of the same thing during different points in time. Area charts

are not designed to provide exact data but they do give users visual clues of the relative sizes of the items they

are representing.
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Add Data to a Chart

Before you can start creating a chart you must choose a data source that contains the data you want to use.

You must then define the data that will be displayed in the chart. If you are unsure what chart type is best for

displaying your data, see Choosing the Correct Chart Type for more information.

Use these steps to add data to your chart.

1.

6.

In the Dashboard, choose a dashboard panel and click

File:/select_content_type.png
(Insert) and choose Chart. The Select a Data Source dialog box appears.

Select the data source from the list of available choices. The data source contains the content you want
to display in your chart. The Query Editor appears.

The Query Editor allows you to retrieve dynamic data from a database for display in a chart. Defining
your query is the first step in ensuring that the correct data is selected. In the Query Editor, click (+)
next to a category name to display its associated table columns.

Click the small green arrow to place the column name under Selected Columns. In the example below,
the Customernumber column has been selected and moved under Selected Columns. Notice that the
column names appear under Selected Columns. Continue adding columns as needed.

File:/06_mql_select_columns.png

Now add the Conditions; these are your constraints that filter what you are choosing. You can add
multiple conditions. In the example below, the search is limited to customer numbers.

File:/07_mql_where_clause.png

Under Combine, you can choose your constraint (and, or, and not, or not) from the drop-down list.
Under Comparisons you can click the drop-down list to display options for comparisons, =, <, >, and so
on; (for example, where the customer number is equal to 144 or 145). You can also choose an
aggregation type from the drop-down list for table columns that contain numeric data. The table below
contains a definition for each aggregate type:

Aggregate Type Description
SUM Sums a column's values
COUNT Counts a column's values
AVG Averages a column's values
MIN Selects the minimum column value
MAX Selects the maximum column value

Click Preview at any time to view the data associated with your query.

Add the columns that you want to Order By. The ordering of the selected data is accomplished by one
or more columns in a table. For example, you can sort the data by customer name and address.
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7.
8.

10.
11.

12.
13.

Click OK in the Query Editor when you are done. The Chart Designer appears.
Under Data, click the drop-down arrow to display and choose the table columns.

File:/17_drag_and_drop.png

Data Definition Description

Series Column Series show up as the individual columns on a bar
chart and as individual lines in a line chart. Area
charts display each series as a point.

Category Column Categories are displayed as bars or groups of bars on
the x-axis (horizontal axis). In line charts, categories
are usually associated with time periods. In area
charts, the x-axis displays the category labels.

If you don't want to display categories, choose
None.

Values Column The value is always numeric. The value determines
the height of columns in a bar chart and the height of
linesin a line chart. In area charts, the y-axis values
determine the heights of the points.

File:/series_category_values.png
A preview of the chart appears in a box in the upper-right corner of the Chart Designer as you choose
your options.

Under Chart Type, click a chart type to choose it. By default, pie and dial charts display in "animated"
Flash mode. You can turn animation off by disabling the Animated check box in the Chart Designer.

Animated charts bring focus to important aspects of your data. For example, animation allows you to
bring out a data point if it reaches a critical value, such as high or low sales numbers. If you selected a

pie or dial chart, see Working with Pie Charts or Working with Dial Charts, respectively.
Under Theme, choose a theme from the list. The theme is applied to your chart.

Enter the labels for the Chart Title, X Axis Title (horizontal axis), and Y Axis Title (vertical axis). Entries
are displayed in the chart preview.

File:/09_chart_preview.png

Click Apply to see the chart preview.
Click OK display your chart in the dashboard panel.
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Work with Pie Charts

A pie chart gives dashboard consumers an immediate visual clue of the relative sizes of the shares of a whole.
Categories are represented by individual slices. The size of the slice in a pie chart is determined by the value.

File:/10_pie_chart_preview.png

You can animate a pie chart if you want its pieces to be exploded, which means that the individual slices of the
pie can be pulled away from the rest of the pie.

File:/19_pie_explosion.png

To animate a pie, enable Animated check box in the Chart Designer.
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Work with Dial Charts

For dial charts to display correctly, you must enter values for your range and the chart title. In the example
below, the dial chart preview is displaying ranges associated with sales. Notice that each dial sector is
represented by a color, red, yellow, or green. The needle is positioned in the 220796.48 range, indicating that

total orders, while not stellar, are not near the danger zone indicated by the red sector in the dial.

File:/11_dial_chart_preview.png

Changing Dial Sector Colors

You can change the color of a dial sector by clicking the small down arrow in the color boxes associated with
Range. Select a color from the palette so that you can preview it on your dial chart. Click Apply to preview your

dial chart. Click OK to place your dial chart into the dashboard.

File:/18_color_picker.png
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Correct Scaling Issues

Use the scaling feature in instances where numeric values in a chart are so long that they affect the display.

Preview your chart in the Chart Designer.

2. Under Scale, click to display the drop-down list of scaling options. In the example below, the scaling
option used is "1000." Notice the change in the display of numeric values when scaling is applied. Users
of the chart can see actual values when they hover over the bars in the chart.
File:/25_scaling_example.png

3. Click OK to display the chart in the dashboard. The scaling feature is available for all chart types except
pie.
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Rotate Chart Axis Labels

If your chart axis labels become unreadable because they are too long, Label Rotation may correct the

problem.

1. Inthe Chart Designer, display your chart.

2. Under Label Rotation, choose Diagonal or Vertical and click Apply. The labels display with the rotation
you set.

3. Click OK to display the chart in the dashboard panel.
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Edit a Chart

Use these steps to edit a chart.

In the Dashboard Designer, choose the panel that is displaying the chart you want to edit.

2. Inthe upper right corner of the panel click

r
(Edit) The Chart Designer appears.

Click Edit Query. The Query Editor opens.

Edit the query as needed and click OK. The Chart Designer appears.

Select the appropriate data definitions to build the chart.

If applicable, change the chart type and theme and click Apply to see a preview of the edited chart.
Click OK to display the chart in the dashboard.

N o v s~ W
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Add a Data Table to a Dashboard

The Data Table feature allows you to display a tabular representation of a database query in a dashboard. It
also allows you and consumers of the dashboard to manipulate the display of the data in the data table, while
in the dashboard. For example, users can resize, sort, and change the order of columns. Follow the instructions

below to add a data table to your dashboard.

Select a panel in the Dashboard Designer.
2. Click

File:/select_content_type.png
(Insert) and choose Data Table. The Select a Data Source dialog box appears.

3. Select a data source from the list of available data sources and click OK. The Query Editor opens.

Begin building your query. Click (+) next to the category name to display its associated table columns.
When the column names appear, click to choose the column that contains the data you want displayed
in your data table.

Click the small yellow arrow to place the column name under Selected Columns.

Now add the Conditions; these are your constraints that filter what you are choosing. You can add
multiple conditions. Under Combine, you can choose your constraint (and, or, and not, or not) from the
drop-down list. Under Comparisons you can click the drop-down list to display options for
comparisons, =, <, >, and so on; (for example, where the customer number is equal to 144 or 145). You
can also choose an aggregation type from the drop-down list for table columns that contain numeric
data. The table below contains a definition for each aggregate type:

Aggregate Type Description
SUM Sums a column's values
COUNT Counts a column's values
AVG Averages a column's values
MIN Selects the minimum column value
MAX Selects the maximum column value

Click Preview at any time to view the data associated with your query.

7. Add the columns that you want to Order By. The ordering of the selected data is accomplished by one
or more columns in a table. For example, you can sort the data by customer name and address.

8. Click OK in the Query Editor when you are done. The Data Table appears in the dashboard panel.
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Update the Data Table Display

You can edit the data table display directly in the dashboard panel.

Sorting Column Data

To change the sort order data under a column, click the drop-down arrow in the header and choose Sort
Ascending or Sort Descending. You can also hide one or more columns by disabling the appropriate check

boxes next to the column names.

Adjusting Column Width

You can adjust the width of a column by clicking the right border of the column header and dragging it to the
right or left. Release the mouse button when you are done.

Moving Columns

To move the placement of a column, click and drag the column it to the appropriate location in the Data Table
as shown in the example below:

Paginating

The pagination feature allows you to page through a large number of records.
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Add a Report Designer Report to a Dashboard

Use these steps to add a report created with Report Designer.

1. Select a panel in the Dashboard Designer.
2. Click

File:/select_content_type.png
(Insert) and choose File. A browser window opens.

3. Locate the appropriate report file.

Click Select to place the report inside the dashboard panel. Pagination control arrows at the top of a
report allows you to scroll through long reports. Notice that the report file name, Inventory.prpt,
appears under Content: in the dashboard edit pane in the sample below. This sample report contains
parameters. You can enter values manually and link them to a dashboard filter in the text boxes under
Source. When the report renders again, the parameter value(s) you entered are included in the report.

Sample Report
Important: If you choose a Report Designer file to place in a dashboard, but do not supply values for
required parameters, the report will show up blank.
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Add an Analyzer Report to a Dashboard

Use these steps to display an Analyzer report in a dashboard.

1. Select a panel in the Dashboard Designer.

Click Insert and choose File.

. Locate the appropriate Analyzer report and click Select. The Analyzer Report appears inside the
dashboard panel.
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Add a Web Site to a Dashboard

Use these steps to display contents of a Web site in a dashboard panel.

1. Select a panel in the Dashboard Designer.
2. Click
.

(Insert) and choose URL. The Enter Web site dialog box appears.

3. Enter the Web site URL in the text box and click OK.
If applicable, click

&
(Edit) to make changes.

5. Save your dashboard when you are done.
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Use Prompts on Dashboards

Prompts display a subset of data based on the dashboard user's point of view. For example, a European user
may only want to see EMEA region sales data, whereas the dashboard's default region is the NA region. To
ensure that a prompt links to the correct content in a dashboard, the content to which you are linking (data

table or chart) must contain at least one parameter.

Below are general instructions below for adding prompts to your dashboard:

1. In the dashboard page, choose Edit (the pencil icon), which will make the Objects pane appear.

2. Under General Settings, choose Prompts. The Prompts pane appears on the right. No prompts are
listed if this is the first time you are assigning prompts.

3. To display a prompt toolbar to users of the dashboard, enable Show Prompt Toolbar. The prompt
toolbar appears at the top of the dashboard.

Click the Add button to start adding prompts. The Prompts dialog box appears.
In the Prompts dialog box, enter a display name for the control label. For example, "Region."

Enable Display Name as Control Label if you want users to see the display name in the prompts
toolbar.

7. Select your control type. Control types define how your prompt values are selected; for example, in a
drop down list, radio button, check box, and so on.

The table below contains a description of each control type.

Control Type Description
Drop Down Users choose a prompt value from a drop-down list.
List Users choose a prompt value from a scrolling list. This

prompt control supports multiple selections.
Radio button Users click a radio button to choose a prompt value.

Check box Users enable a check box to choose a prompt value.
This prompt control supports multiple selections.

Button User click a button to choose a prompt value. This
prompt control supports multiple selections.

Text Field Users enter a text string or number into a text field
manually.

Date Picker Users examine prompt values based on calendar
date.

Your dashboard now has a prompt.
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If you plan to provide hard-coded names and values for your dashboard users, or produce a dynamic prompt
list, continue on to the next few sections.

+ Add a Prompt to a Dashboard

+ Create a Metadata List

+ Create a Cascading Prompt

+ Edit Prompts

+ Link Dashboard Prompts to Analyzer Parameters
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Add a Prompt to a Dashboard

You can create a prompt tool bar that enables users to refine report results in a dashboard. First create the
Prompt Toolbar. Then customize the toolbar so that the appropriate options appear.

Creating a Prompt Toolbar for Dashboards

Open a dashboard that contains at least one parameterized report.

Click the Edit Content icon to open the editing options in the dashboard.

In the bottom section, inside the Objects pane, choose Prompts to access the Prompt pane.
Click Show Prompt Toolbar to display the prompt toolbar to dashboard users.

Click Add to add a prompt. The Prompt dialog box appears.

In the Name field, enter the title for the prompt toolbar.

No v sk wbnN--

In the Control box, click the format for the prompt options. For example, you can choose the Drop
Down control if you want a list that appears when users click the first option.

8. Ensure that Static List is selected under Type.

Customizing a Prompt Toolbar for Dashboards

1. In the Data box, click Add. The List Value dialog box appears.
In the Label field, enter the option name as you want it to appear to dashboard users.
In the Value field, enter the parameter source name. For example, using the Steel Wheels sample, enter
Classic Cars.

4. Add labels and values for each parameter you want to filter. Click Close to exit the List Value dialog
box. If you are filtering an Analyzer report and using a static list, you can add the option All. This option
drops the filter from the report and shows all values.

5. Inthe Control Properties box, under Initially Selected:, choose which item you want to appear first in
the prompt list. Choose Use First Value to set the default to the first value in the list, or you can choose
Specify if you want a specific value to appear first.

Click OK.

In the Objects pane, choose the title of the report you want to filter. Click the Parameters tab and
choose the correct Source for the parameter from the list. The source should be the name of your

prompt.
8. Click Save.
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Create a Metadata List

You must have a data table or chart that contains at least one parameter for your prompt control to function
correctly.

When you create a Metadata List, you are defining a query to retrieve a list of display names and

corresponding values from a metadata data source provided by your administrator.

File:/37_filter_props_metadata.png

1.

10.

11.

12.

13.

In the dashboard page, under General Settings, choose Prompts. The Prompt Editor appears on the
right. No prompts are listed if this is the first time you are assigning prompts.

To display a prompt toolbar to users of the dashboard, enable Show Prompt Toolbar. A placeholder for
the prompt toolbar appears at the top of the dashboard.

Click

File:/add.png
(Add) to add a prompt. The Prompts dialog box appears.

In the Prompts dialog box, enter a Name for your prompt.
Under Data Type, choose Metadata List.

Click Select to choose the data source that contains the content you need to set options from the drop-
down list and click OK. The Query Editor opens.

In the Query Editor, build a query to choose either a single column (that represents both a name and a
value), or two columns representing the display names and corresponding values. If a single column
query is defined, the values of that column will be used for both the display names and the values.

Click OK to exit the Query Editor. Your options appear under Selected Items in the Prompts dialog box.
Under Control Properties, enter a Default Label/Value for the initially selected option in your prompt
control.

File:/80_metadata_list_example.png

Select a Label to display in the prompt control; this is the user-friendly name that users will see in the
dashboard.

Select the Value; this is the value in the database that is associated with the Label you selected in the
previous step.

If applicable, choose your Display type from the list. Some prompt controls allow you to choose the
position of your prompt options. If you have a long list of options, for example, a list of cities, options
may not appear correctly in the user console unless you change the Display type to Horizontal.

Click OK.

The list of values appear in the prompts toolbar in the dashboard.
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Create a Cascading Prompt

A cascading prompt changes based on a value a user selects. When the value in the drop down list, (Country),
changes, the prompt is automatically applied to the second prompt, (City) thus changing its values.

File:/82_cascading_filter_sample.png
The example above was created using a Metadata List for the drop-down prompt (Country).

File:/84_cascading_metadata_query_sample_filter.png

A SQL List that included a parameter, ${selected_country}, in its associated query was used for the check box
prompt (City).

File:/85_cascading_sql_query_sample_filter.png

The Default Value for the selected_country parameter was set to USA with New York City (NYC) as the initially
selected value for the check box prompt.

File:/86_cascading_sql_query_parm.png

To link the City prompt to the Country prompt, another Source for the selected_country parameter was

chosen. The alternate source is the Country prompt.

File:/87_cascading_filter_select_source.png

When the prompts are linked, users can choose a country and then choose a city (or cities) in the country of

their choice.

Using this example, the report designer can now add a data table, chart, or other content in the dashboard
that can be driven by the prompt he or she just created. Suppose the designer decides to add a pie chart to the
dashboard. The pie chart will display the percentage of sales per city.

In the Query Editor, the report designer creates a parameter, {City}, with an extended default value: NYC|Las
Vegas. The resulting pie chart displays values for New York City and Las Vegas. Under the Parameters tab

associated with the pie chart, the Source value for the City parameter is changed to the City prompt.
File:/88_cascading_filter_init_piechrt.png

When the report is saved, users of the dashboard can see results for a country and multiple cities in that

country.

File:/89_cascading_filter_final_piechrt.png
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Edit Prompts

You can edit prompts as needed. Use these steps to edit prompts.

Locate the prompts pane at the top of the panes in the dashboard.
Located the different prompts and the drop-down menus next to them.

Select the prompt you want to edit and choose an alternative prompt from the drop down menu. The
prompt changes, causing the graphs and charts in the dashboard to change appropriately.
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Link Dashboard Prompts to Analyzer Parameters

This process only applies to dashboards that include parameterized Analyzer reports. You must have an
Analyzer report with a query parameter in it in order to proceed.

The instructions below explain how to parameterize an Analyzer report.

1. In Analyzer, choose a field in your report to which you want to link; then, right-click and choose Filter.
In the example below, data will be filtered by Territory.

File:/44_ana_filter.png

2. Inthe Filter dialog box, enter a name for the parameter in the Parameter Name text box and click the
check box to enable it.

File:/45_ana_parm_name.png

3. Select the values you want associated with the parameter. Use the arrows to add values to the box on
the right.

File:/46_ana_filter_values.png
Click OK to exit the Filter dialog box.
Save your Analyzer report.

In the upper left corner of the report, you can see that a filter is in use. Click

File:/edit.png
(Edit) to edit your filter; click

File:/27_delete.png
to delete the filter.

File:/47_ana_filter_in_use.png
6. Create a dashboard and drag the Analyzer report into a panel.
The name of the parameter appears in the lower portion of the dashboard under Parameters.

7. Add a filter to the dashboard based on the parameter you created in your Analyzer report. The filter
appears in the dashboard.
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Dashboard Parameters

If you are placing a file, such as an .xaction or .prpt, inside a dashboard panel, it is possible that the author of
the file defined meaningful parameters for the content. If previously defined, the parameters and their
associated default values, appear under Parameters in the edit pane of the dashboard. In the example below,
when the chart initially rendered, it displayed a parameter called, "chart_type" with a default value called, "bar."

A user can change the value of the parameter to see the content rendered as a pie, line, or area chart.

Users can change the value of a parameter

Parameter names are "hard-coded," in the file; that means they cannot be changed. Neither can you change
the number of parameters associated with a file. When you create a chart using the Chart Designer, embed a

URL into a dashboard, or create a data table, you can change both the name and value of a parameter.

In Windows, the URL Parameters have a maximum limit of 2,048 characters, minus the number of characters in

the actual path.

* Create Chart or Data Table Parameters With the Query Editor
+ Dynamic Dashboard Titles
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Create Chart or Data Table Parameters With the
Query Editor

When you place a chart in a dashboard panel, you use the Query Editor to retrieve data from a database for
display on your chart or data table. If applicable, you can add conditions or constraints that filter the data so

that the chart or data table displays the information you want dashboard consumers to see.

Using parameters is critical if you plan on using dashboard prompts or linking content in one dashboard panel
to content on another dashboard panel. For example, suppose you create a pie chart and you want to filter
details associated with an exploded pie slice in the adjoining data table as shown in the example below. In this
instance, you must use a parameter that allows the data table to update when a dashboard consumer clicks on
a pie slice. Optionally, you can parameterize the query condition so that the content is updated based on a
user interaction, such as changing a prompt value.

Content Linking Sample

To create a parameter, in the Value field, enter the name of the parameter inside curly braces, as in
{Parameter Name}. In the example below, the designer created a parameter called, {TERRITORY}; the default
value, or source, for the parameter is, "NA" (North America). When a chart or data table renders, it displays
data associated with North America. Remember that this a default value. When you enclose a parameter name
with curly braces, you are creating a parameter query. That means, that users can change the query dynamically

by replacing the default, "NA," with a different territory acronym, (for example, EMEA), when the query runs.
File:/49_filterparm_sample.png

You can define multiple default parameter values by adding a pipe (|) between the values, as in
NA|EMEA | APAC.

Suppose a dashboard designer chooses to limit the data to North America (NA) exclusively? In this instance, he
or she would not include the curly braces around "NA," (as shown in the example below), and Default (value) is
disabled. This is an example of a static query.

File:/60_filterparm2_sample.png
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Dynamic Dashboard Titles

While in Dashboard, each panel has the ability to show a title with current parameters.

1. Click the edit (pencil) icon in the top toolbar. The Edit Pane appears at the bottom of the screen

2. Click the report that has the parameters you are going to change. You will need to go through this
process for each report to which you want to add parameters.

3. Click the Add Parameter button.

File:/parameter_added_callout.png
Placed parameter appears after the title.

Click Apply
5. Close the Edit Pane by clicking the edit (pencil) icon.

File:/parameters_applied.png
The title will now show the parameters applied to it.

https://help.pentaho.com/Documentation/5.2/0L0/120/040/020/010 90/105
Updated: Tue, 30 Sep 2014 01:20:21 GMT



@ pentaho

Use Content Linking to Create Interactive Dashboards

Depending on your needs, you can create a "static" dashboard, which contains content in each panel that is
separate but related. For example, you may provide users with a bar chart that contains total sales figures by
region. Additionally, you may provide a data table that displays sales details for each state in a specific region.
You may also want to provide sales data associated with each salesperson in a specific region. The content in
your dashboard is useful to dashboard consumers, but to make it more "interactive," you may want to

consider using content linking.

The content linking features in dashboards allow you to associate (link) content in one dashboard panel to
content on another dashboard panel as long as query parameters have been defined. These features are
particularly helpful for drilling down or for dynamic filtering; for example, when dashboard consumers explode
a single slice in a pie chart to launch content in a data table associated with that pie slice. In this instance,

dashboard consumers are moving from a summary view to a detailed view interactively.

You can use content linking if your dashboard panel contains a data table, chart, .xaction, .prpt, and Analyzer

report.

Content Linking and Query Parameters

Query parameters are required for content inside a dashboard panel to receive values used to filter data from
a filter control. They are also required when receiving values from content in other dashboard panels that are
broadcasting values associated with Content Linking. The way in which query parameters are defined is

different depending on the type of content you are placing inside your dashboard panels:

If Then
You are defining parameters in the Analyzer... See Adding Query Parameters to Analyzer Reports
You are defining parameters for a chart or data table... Use the Query Editor to define your parameterized query.

See Linking Charts and Data Tables and Linking Columns
in a Data Table to Content in other Dashboard Panels

+ Link Charts and Data Tables
+ Link Columns in a Data Table to Content in other Dashboard Panels

+ Create Content to Content Links in an Analyzer Report
+ Link an Analyzer Chart to a Report
+ Control a Dashboard Parameter From a PRPT Hyperlink
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Link Charts and Data Tables

Below are general instructions for linking charts and data tables in a dashboard. This is just an example. You
must adjust the instructions when working with your own data.

1. Create a simple dashboard that contains a chart and a data table. At this point, none of the content has
been linked and you have a "static" dashboard.

File:/48_simple_dshbrd_sample.png

Notice the pie chart in the example above. You want dashboard consumers to click a slice (NA, APAC,
Japan, EMEA) and have the data table on the right update with the values associated with that slice
exclusively. For example, if a report consumer clicks the EMEA slice, the data table will display values
associated with EMEA and nothing else. To get the correct filter display, you must first create a

parameterized query that drives the content in the data table.

2. Click the Edit Button to open up the Edit Pane at the bottom of the screen. Within the Objects pane,
choose the report you want to parameterize. Parameterizing a query, as described here, allows you to
pass values dynamically and update the chart based on events triggered by other elements of the
dashboard such as a user choosing an item from a filter control or following links defined in content
associated with another panel in the dashboard.

3. Click the {p} button next to the Title box. The parameters will populate after the title in the Title box.
Click the Parameters tab and ensure that the parameters name is linking to the correct Source.

5. Click Apply.
The new source for the parameter corresponds to the title of the dashboard panel that contains the

chart as shown in the example above. This new source will now drive the display in the data table.

6. Click the Edit button (pencil icon) to exit the edit mode. The filters will appear after the panel titles.

7. Save your dashboard. See Saving Your Dashboard.

When users click a pie slice or bar in a chart, the data table displays content associated with that specific pie
slice or bar. The currently applied filters appear after the title.
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Link Columns in a Data Table to Content in other
Dashboard Panels

The instructions that follow show you how to link a chart to a column in a data table. You must adjust the

instructions when working with your own data.

1.

Create a simple dashboard that contains a data table and a bar chart. At this point, none of the content
has been linked and you have a "static" dashboard.

File:/55_content_link_on_column.png

Notice the data table in the example above. You want dashboard consumers to click a product in the
Product Line column and have the bar chart update with information about sales by territory for that

specific product line.

Add a parameterized condition to the query for the bar chart by specifying a parameter name in curly
braces in the Value text box; then, provide a default value for that parameter in the Default text box. In
the example below, a parameter called Productline with a default value of Classic Cars has been
created.

File:/56_content_linking_parm_query.png

In the Chart Designer, set the data definitions for the series, category and values columns associated
with your bar chart and click OK.

Under General Settings, choose the data table and click the Content Linking tab. Enable content
linking on the column in your data table that will filter content in your chart. Each of the columns in a
data table are able to broadcast values to other dashboard components.

File:/58_parm_value_for_linking_2.png

Under General Settings, choose the chart and click the Parameters tab. Click the down arrow, in the
Source text box to display another source for the parameter you created. In the example below, notice
that Order Details - Product Line, (this is the name of the dashboard panel that contains the data
table), can now be selected as a source for the Productline parameter.

File:/64_parm_new_source.png

Save your dashboard.

In the data table, choose an item in the column that has content linking enabled. The content in the
chart updates in response to the item that was clicked in the data table.

In the example below, the Product Line column was enabled for content linking.

File:/59_completed_linked_bar_chart.png
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@ pentaho

Create Content to Content Links in an Analyzer Report

Below are general instructions for creating content links in an Analyzer report, (inside a dashboard), that can

be used to drive the parameter values of content in other dashboard panels. You must adjust the instructions

when working with your own data.

1.

5.

Create a simple dashboard that contains an Analyzer Report and a data table. At this point, none of the
content has been linked and you have a "static" dashboard.

File:/65_analyzer_table_content_linking.png

In the example above, when content linking is achieved, the list of territories (APAC, EMEA, Japan, and
NA) will become hyperlinks that, when clicked, will update customer details data table. To get the

correct filter display, a parameterized query that drives the content in the data table must be created.

Add a parameterized condition to the query for the data table by specifying a parameter name in curly
braces in the Valuetext box; then, provide a default value for that parameter in the Default text box. In
the example below, a parameter called TERRITORY with a default value of NA has been created.
Parameterizing a query, as described here, allows you to pass values dynamically and update the chart
based on events triggered by other elements of the dashboard such as a user choosing an item from a
filter control or following links defined in content associated with another panel in the dashboard.

File:/49_filterparm_sample.png

Under General Settings, click the data table and examine its available parameters. In the example
below, there is an available parameter called TERRITORY with a default source value of NA (North
America). A drop-down arrow in the Source text box indicates that there are additional values to
control the available parameter. In this example, there are no additional source values that control the
TERRITORY parameter.

File:/66_parameter_query_on_territory.png

Under General Settings, choose the Analyzer report. Click the Content Linking tab then click the check
box next to the field/column name you want enabled for content linking. Click Apply.

File:/68_content_linking_enabled_fields.png

In the Analyzer report, the values under the Territory become hyperlinks.

File:/69_analyzer_hyperlinks.png

Under General Settings, choose the data table and examine its available parameters. Notice that there
is a drop-down arrow in the Source text box. Click the down arrow to display and choose a new source
value for the available parameter. Click Apply.

Save your dashboard.

In the example below, content linking was applied. When users click a territory hyperlink in the Analyzer report,

the data table updates and displays customer-related details associated with that specific territory exclusively.
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File:/70_analyzer_table_content_linking_complete.png
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@ pentqho

Link an Analyzer Chart to a Report

You can create content-to-content links between an Analyzer chart and any other parameterized report such

as a Report Designer report, a data table, or another Analyzer report.

Below are general instructions for linking an Analyzer chart to a report. You must adjust the instructions when

working with your own data.

1. Create a simple dashboard that contains an Analyzer chart and a parameterized report. The example
above displays an Analyzer chart and an Analyzer Report displayed as a table view. At this point, none
of the content has been linked and you have a "static" dashboard.

Hypothetically, if you want users to be able to click a bar in the bar chart and update the Analyzer table

view, the table must contain at least one parameter. In the example below, there are two parameters,
(LINE and TERRITORY), associated with the Analyzer table.
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2. Under General Settings, choose the Analyzer chart. Click the Content Linking tab then click the check
box (or check boxes) next to the field/column name you want enabled for content linking. Click Apply.

Tarritary

Lina

LTy

|4

3. Under General Settings, choose the Analyzer Report (table view) and click the Parameters tab. Click the

down arrow, in the Source text box to display another source for the parameters you created. In the
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example below, notice that Sales by Line, (this is the name of the dashboard panel that contains the
chart), can now be selected as a source for both the TERRITORY and LINE parameters.
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4. Save your dashboard. See Saving Dashboards for steps.

In this example, content linking is applied when users click a bar in the bar chart. The data table updates and

displays sales details for a product line in a specific territory.
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@ pentaho

Control a Dashboard Parameter From a PRPT
Hyperlink

You must have a report (.prpt) that contains a hyperlink before you can complete this task. See the Design
Print-Quality Reports section for instructions about adding hyperlinks to a report.

The instructions that follow show you how a link inside a Report Designer report (.prpt) can drive a parameter

in content on another dashboard panel. You must adjust the instructions when working with your own data.

1.

5.

Create a simple dashboard that contains a .prpt report and a data table. At this point, none of the
content has been linked and you have a "static" dashboard.

File:/71_prpt_content_linking.png

Notice the report (.prpt) in the example above. You want dashboard consumers to click a territory
(APAC, EMEA, etc.), hyperlink and have the data table update with information about that territory
specifically.

Under General Settings, choose the report (.prpt) and click the Content Linking tab. Click the checkbox
next to the field you want used for content linking.

Add a parameterized condition to the query for the data table by specifying a parameter name in curly
braces in the Valuetext box; then, provide a default value for that parameter in the Default text box. In
the example below, a parameter called TERRITORY with a default value of NA has been created.

File:/49_filterparm_sample.png
Parameterizing a query, as described here, allows you to pass values dynamically and update the data
table based on events triggered by other elements of the dashboard such as a user choosing an item

from a filter control or following links defined in content associated with another panel in the
dashboard.

Under General Settings, choose the data table and click the Content Linking tab. Click the drop-down
arrow, in the Source text box to display another source for the parameter you created. In the example
below, notice that Product Line Share by Territory - Territory, (this is the name of the dashboard
panel that contains the .prpt), is now selected as a source for the Territory parameter.

File:/72_prpt_content_linking_select_parm.png

Save your dashboard. See Saving Dashboards.

When content linking is achieved, the data table updates when a link in the report (.prpt) is clicked as shown in
the example below.

File:/73_prpt_content_linking_final_result.png
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@ pentaho

Add Content to a Dashboard Using Drag-and-Drop

Use these steps to add an existing chart, table, or file to your dashboard panels using the drag-and-drop

feature.

1.
2.

Create a new dashboard. See Creating a New Dashboard for specific instructions.

In the left pane of the Pentaho User Console, under Files, locate to the content (chart, table, or file) you
want added to your dashboard.

Click and drag the content into a blank panel on your dashboard. You will see the "title" of the content
as you move it around the dashboard. Notice that the title background is red; it turns green when you
find a panel where the content can be dropped.

Repeat steps 2 and 3 until your dashboard contains all the content you want to display. To swap
content from one panel to another, click the title bar of the panel that contains the content you want
moved and drag it over the panel you want swapped. You will see the swap icon as you are moving the

content.

If you are working with an existing dashboard, you can perform steps 2 and 3 steps; however, a
warning message appears when you try to place content in a panel that already contains content. The

new content will override the existing content.

4. Save your dashboard.

https://help.pentaho.com/Documentation/5.2/0L0/120/040/040
Updated: Tue, 30 Sep 2014 01:20:21 GMT

99/105



@ pentaho

Adjust White space in Dashboard Panels

Sometimes you must adjust the white space in dashboard panels, (or the filter panel), so that content appears
correctly. Use these steps to adjust white space.

Open an existing dashboard.
In the lower pane, click General Settings and then click the Properties tab.
Click Resize Panels. The white space between the dashboard panels turns blue.

Adjust the panel size by clicking and holding the left mouse button down as you move the blue lines
(white space) around. Release the mouse button when you are satisfied with the positioning of the
panel.

El e

File:/42_dshbrd_resize.png
Click Close in the lower-right corner of the dashboard to exit resize layout mode.

Examine the dashboard contents to make sure they are placed correctly. You can return to the resize
layout mode if you need to make additional changes.

7. Save your dashboard.
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@ pentaho

Set the Refresh Interval

The content in your dashboard may need to be refreshed periodically if users are examining real-time data.
You can set refresh intervals for individual panels on your dashboard or for the entire dashboard.

To set the refresh interval for individual panels in the dashboard, click the edit button and the choose the panel
that contains the content you want refreshed in the Objects panel . Under Refresh Interval (sec) enter the

interval time in seconds and click Apply.

If you want the entire dashboard to refresh, click the Prompts tab in the dashboard and set your refresh
interval.
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@ pentaho

Schedule Reports

You can use the Schedules page of the User Console to schedule a report to run at regular intervals, on certain
dates and times, and with different parameters. You can also set a scheduled report to be emailed
automatically, if your system administrator has configured the server for emailing reports. After you schedule a
report, you can pause or delete a schedule, as well as edit the schedule to change the frequency of the report,

parameters, or email settings.

The system administrator may set up times when you cannot run a scheduled report, for example, to perform
system maintenance, or to minimize scheduling during peak times. If any blocked out times are set up, you can

view these times so you can choose an alternate schedule.

Schedule a Report

You can create a schedule and designate the frequency of the scheduled report, report parameters, and email

settings.

1. Login to the User Console, and click Browse Files to browse to the location of your report.

2. Double-click the folder containing your report in the Browsing pane on the left, then click to select the
report you want to schedule from the middle pane. The File Actions pane on the right of the Browse Files
window populates with a list of actions that you can do with the selected report.

3. Select Schedule from the File Actions pane. The New Schedule window appears.

4. Enter a name for the schedule in the Schedule Name field. If no name is entered in the Schedule Name
field, the default is the name of the report file.

5. Choose a time interval for the report from the Recurrence list. To enter a custom time interval, choose
Cron and consult the Quartz reference to learn the Quartz Cron syntax. If blockout times have been
scheduled by your administrator, a View Blockout Times button appears on the bottom of the New
Schedule window. A list of blockout times is viewable by clicking View Blockout Times.

6. Choose a Start Time and a Recurrence Pattern, as well as Start and End Dates for the report. Click
Next.

7. Choose what type of file you would like the schedule to create from the Parameters field. Click Next.
The email option will only appear if your system administrator has enabled email on the server.

h. A. If you do not want to email a copy of the report, choose No.
i. B. If you want to email a copy of the report, choose Yes. Type to fill in or edit the fields that appear.
8. Click OK.

The schedule is created and appears in the list in the Schedules window of the console.

Edit a Schedule

You can edit a schedule to change the frequency of the scheduled report, report parameters, and email

settings.
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1. Click the Home drop-down menu on the upper-left and click the link to the Schedules. The list of
schedules appears in the Schedules page.

2. Click the schedule you want to edit in the list, then click Edit in the scheduling toolbar. The Edit
Schedule window appears.

3. Type to rename the schedule in the Schedule Name field.
4. Choose a new time interval for the report from the Recurrence list.

5. Choose a new Start Time and Recurrence Pattern, as well as new Start and End Dates for the
schedule. Click Next. If blockout times have been scheduled by your administrator, a View Blockout Times
button appears on the bottom of the New Schedule window. A list of blockout times is viewable by clicking
View Blockout Times.

6. Choose what type of file you would like the schedule to create from the Parameters field. Click Next.
The email option will only appear if your system administrator has enabled email on the server.

g. A. If you do not want to email a copy of the report, choose No.
h. A. If you want to email a copy of the report, choose Yes. Type to fill in or edit the fields that appear.
7. Click OK.

The schedule is edited and appears in the list in the Schedules window of the console.

Delete a Schedule

After you have scheduled a report, you can easily delete the schedule without deleting the report.
1. Click the Home drop-down menu on the upper-left and click the link to Schedules. The list of schedules
appears in the Schedules page.
2. Click the schedule that you want to delete in the list. The schedule is highlighted.
3. Click Delete in the upper right of the toolbar to delete the highlighted schedule. This deletes the
schedule while leaving the report intact.

The previously scheduled report no longer runs at the specified interval.
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@ pentaho

Quartz Cron Attributes

The Quartz cron engine supports a seven-attribute time declaration with many possible values. The number
format is the same for every expression, even if the values are different -- it must be listed as seconds,
minutes, hours, day of month, month, day of week, then the year. A space separates each attribute.

These are the possible values for each attribute: 0 to 59 for seconds and minutes, 0 to 23 for hours, 1 to 31 for
days, 1 to 12 for months, 1 to 7 for day of week, and a four-digit year. Alternatively, you can use three-letter
values for the day of week (MON, TUE, WED, THU, FRI, SAT, SUN), and three-letter values for the month (JAN,
FEB, MAR, APR, MAY, JUN, JUL, AUG, SEP, OCT, NOV, DEC).

An asterisk (*) indicates all values, so an asterisk in the minute field would mean that the report runs once
every minute. You can specify a range of values with the - (dash) operator, and you can specify multiple
individual values with a comma. If you need to excuse a value in the day of month and day of week field from a
cron job, you can use the question mark (?) character to indicate that this value doesn't matter. If you need to
split values, you can do so with the slash (/) character -- this operator literally means "every," so */15 would
mean "Every 15." In the day of month field, you can use the # character to indicate a certain instance of a day
of the month, for instance the second Friday of the month would be 6#2. Lastly, you can use a capital L in the
day of month and day of week field to indicate "Last," as in the last day of the week. A capital C in either of
these fields means "Calendar," and combined with a number means that the report should execute a the
interval indicated by the C number according to the loaded calendar. A capital W in the day of month attribute
means "Weekday," which only encompasses Monday through Friday. Most of these values can be combined to

create unusual cron schedules.

Attribute Conditionals and Operators
Seconds ,-*
Minutes ,-*
Hours ,-*
Day of month ,-*?2/LWC
Month ,-*
Day of week ,-*?2/LCH#
Year ,-*
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Here is how you would execute a report at 10:15 AM on every last Friday of every month during the years 2008,
2009, 2010, 2011, 2012, and 2013.

0 15 10 2 * 6L 2008-2013
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